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ВВЕДЕНИЕ 
 
Автоматизация научных расчетов, ориентированных на создание но-

вых технических объектов, базируется на применении современных про-
граммных средств. Курс лабораторных работ направлен на изучение сис-
темы инженерных и научных расчетов MATLAB, разработанной фирмой 
The MathWorks, Inc. Эта система представляет собой язык программирова-
ния высокого уровня для технических расчетов. Она включает в себя про-
ведение вычислений, визуализацию и программирование в удобной среде. 
Наиболее распространенные научные задачи, решаемые с помощью 
MATLAB – это: 
• математические вычисления; 
• моделирование; 
• анализ и визуализация данных; 
• научная и инженерная графика; 
• разработка приложений, включая создание графического интерфейса. 

MATLAB (matrix laboratory – матричная лаборатория) – это интерак-
тивная система, в которой основным элементом данных является массив. 
Это позволяет эффективно решать различные задачи, связанные с техниче-
скими вычислениями, особенно те, в которых используются матрицы и 
вектора. MATLAB фактически представляет собой стандартный инстру-
мент для применения математических численных методов в исследованиях 
технических объектов. 
В MATLAB важная роль отводится специализированным группам про-

грамм, называемым toolboxes. Они очень важны для большинства пользо-
вателей MATLAB, так как позволяют изучать и применять специализиро-
ванные методы. Toolboxes – это всесторонняя коллекция функций – про-
грамм, написанных на языке MATLAB (М-файлов), которые позволяют 
решать частные классы задач. Toolboxes применяются для обработки экс-
периментальных данных, моделирования механических систем, решения 
задач оптимизации, исследования систем управления и т. д. 

Работа с системой MATLAB начинается с запуска программы из 
главного меню Windows или с помощью ярлыка на рабочем столе. В ре-
зультате на дисплее открывается главное окно MATLAB: окно управ-
ления Command Window. Основную часть окна занимает рабочее по-
ле, предназначенное для ввода команд с клавиатуры и просмотра резуль-
татов. Оно является основным средством взаимодействия пользователя с 
системой и обеспечивает ведение диалога посредством командного языка 
MATLAB. Это означает, что любая информация, вводимая пользователем в 
командной строке, воспринимается системой как команда, подлежащая ис-
полнению. Командная строка начинается с символа приглашения: >>. 
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Вывод информации в рабочее поле производится в режиме прокрутки, т.е. 
при выводе на экран очередного сообщения более старая информация сдвигает-
ся вверх. Информация, введенная пользователем или выведенная в рабочее 
поле системой, сохраняется в течение всего сеанса работы. При необходимости 
ее можно просмотреть, используя полосы вертикальной и горизонтальной 
прокрутки. 
Команды, вводимые пользователем в течение сеанса работы, сохраняются 

в буфере команд. Выполнявшуюся ранее команду можно выполнить без 
повторного набора, вызвав ее на экран с помощью клавиш управления кур-
сором (↑ или ↓). 
Все переменные, создаваемые пользователем, содержатся в памяти 

системы MATLAB – в рабочей области (Workspace). MATLAB спосо-
бен использовать всю доступную оперативную память ЭВМ, что делает 
возможной обработку больших объемов данных. 

 
 

ВВОДНОЕ ЗАНЯТИЕ 
 

Цель занятия: ознакомиться с основными возможностями системы ин-
женерных и научных расчетов MATLAB 5.x или MATLAB 6.5 с помощью 
демонстрационной программы introrus.m. 
Следует законспектировать команды создания переменных, векторов, 

матриц, арифметические операции, функции построения графиков и т.д. 
Для этого необходимо запустить из командной строки в рабочем 

поле MATLAB русифицированную программу introrus.m, написан-
ную на языке MATLAB 4 версии: 
>> introrus (нажать Enter) 
Смена экранов осуществляется нажатием любой клавиши. При выпол-

нении графических команд появляется окно Figure1. Для просмотра 
графиков после каждой смены экрана можно переключаться между окнами 
Figure1 и главным окном MATLAB с помощью мыши или клавиш 
Alt+Tab. 
Прервать выполнение программы introrus можно нажатием клавиш 

Ctrl+C. 
По окончании работы с программой introrus запустите из команд-

ной строки программу demo. Особое внимание следует обратить на разде-
лы, посвященные 2D- и 3D-визуализации. 
По окончании занятия выписанные команды и функции MATLAB с 

пояснениями проверяются преподавателем. 
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Лабораторная работа № 1 
ГЛАВНОЕ МЕНЮ MATLAB 

 
Главное меню окна Command Window по форме аналогично меню 

пользователя любого Windows-приложения. Главное меню MATLAB 5.2 
содержит следующие разделы: 
•  File (команды работы с файлами и опции настройки системы); 
•  Edit (команды редактирования информации, отображенной в рабочем по-
ле); 
•  Window (список открытых окон приложения); 
•  Help (команды вызова доступных средств помощи). 
Ниже строки основного меню расположена панель кнопок, обеспечи-

вающих быстрый доступ к наиболее часто используемым командам из раз-
делов меню. 
Из перечисленных выше разделов меню наибольший интерес представ-

ляет раздел File. Содержащиеся в нем команды разбиты на несколько 
групп: 
• команды работы с файлами (New, Open, Run Script); 
• команды работы с рабочей областью (памятью) MATLAB; 
• опции настройки системы (Set Path, Preferences); 
• команды вывода на печать (Print Setup, Print); 
• список файлов, открывавшихся в последнее время; 
• команда выхода из MATLAB (Exit MATLAB). 

 
При выполнении лабораторной работы следует законспектировать 

назначение подпунктов меню; создать M-файл с помощью редактора-
отладчика программ Editor/Debugger (пункт меню 
File→New→M-File); создать графическое окно (пункт меню 
File→New→Figure); открыть существующий M-файл (пункт меню 
File→Open); запустить на выполнение программу introrus.m (пункт 
File→Run Script, Browse); просмотреть содержимое рабочей об-
ласти, т.е. какие переменные имеются в памяти MATLAB (пункт 
File→Show Workspace). 
Для того, чтобы запустить на выполнение из командной строки какую-

либо программу, написанную на языке MATLAB, т.е. созданный пользова-
телем M-файл (например, introrus.m), предварительно нужно указать 
системе путь к этому файлу. При этом используется пункт меню 
File→Set Path. Появляется окно MATLAB Path, которое обеспечива-
ет выбор каталога (папки), в котором лежат M-файлы. Например, для до-
бавления рабочей папки с M-файлами пользователя d:\Study\31SM 



 

 

 

6 

необходимо нажать на кнопку Add to Path... и выбрать эту папку в 
дереве каталога. Ту же операцию можно выполнить из командной строки 
в рабочем поле, выполнив команду 
>> path(path, ’d:\Study\31SM’) 
Добавьте к списку путей каталог, содержащий M-файлы.  

File→Preferences. Опция обеспечивает выбор форматов представ-
ления числовой и текстовой информации в командном окне, формата копи-
рования данных в буфер обмена и настройку ряда других параметров систе-
мы. 
Окно Preferences имеет три вкладки: General (общие параметры сис-

темы), Command Window Font (выбор шрифта для командного окна 
MATLAB) и Copying Options (опции копирования). 
Вкладка General дает возможность произвести настройку следующих 

параметров. 
1. Формат вывода числовых данных (Numeric Format); пользователю 

предлагается выбрать один из 10 вариантов: 
• Short – вывод в формате с фиксированной точкой, выводится 4 знака 
после десятичной точки (используется по умолчанию); 
• Long – формат с фиксированной точкой, выводится 14 знаков после точки; 
• Hex – шестнадцатеричный формат; 
• Bank – формат для вывода денежных сумм; 
• Plus – вывод только знака положительных и отрицательных чисел; 
• Short Е – вывод дробных чисел в формате с плавающей запятой (в экс-
поненциальной форме), мантисса содержит 5 значащих цифр; 
• Long Е – вывод дробных чисел в экспоненциальной форме, в дробной 
части 
мантиссы выводится 15 значащих цифр, для вывода порядка числа в двух по-
следних форматах используется три знакоместа; 
• Short G – «улучшенный» короткий формат, в дробной части числа 
выводится одна дополнительная значащая цифра; 
• Long G – «улучшенный» длинный формат, в дробной части числа так-
же выводится одна дополнительная значащая цифра; 
• Rational – формат, при использовании которого дробные числа пред-
ставляются в виде простых дробей (числитель/знаменатель). 

2. Формат использования рабочего поля командного окна. Может быть 
указан либо Loose –  «свободный» (используется по умолчанию), либо 
Compact. При использовании формата Loose выводимые системой сооб-
щения (ответы) разделяются одной пустой строкой. Формат Compact обес-
печивает вывод сообщений в каждой строке рабочего поля. 
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Выбирая разные форматы, вводите в командной строке дробные 
числа. Обратите внимание на формат вывода результата. 
Вкладка Copying Options позволяет установить параметры для опе-

раций копирования графиков (например, для последующей вставки в доку-
менты MS Word). Clipboard Format – выбор формата копирования в бу-
фер обмена: 
• Windows Metafile – WMF-формат; используется для хранения вектор-
ных рисунков (при увеличении размеров изображения его качество не ухудша-
ется); 
• Windows Bitmap – BMP-формат; обеспечивает хранение растровых (точеч-
ных) изображений. 
Пункт меню Edit аналогичен пункту «Правка» MS Word. Можно копи-

ровать выделенное содержимое рабочего поля (Edit→Copy), вставить текст 
в командную строку (Edit→Paste), вырезать текст из активной командной 
строки (Edit→Cut). 
Очистка рабочего поля производится с помощью команды 

Edit→Clear Session. Важно помнить, что переменные в рабочей об-
ласти (в памяти) при этом сохраняются. 
Пункт меню Window позволяет переключаться между открытыми ок-

нами MATLAB. 
Пункт Help→MATLAB Help вызывает справку MATLAB. В поле 

MATLAB Help необходимо набрать имя интересующей функции. 
Вызовите справку по функции построения плоских графиков 

plot. 
 
 

Арифметические операции в MATLAB 
 

Основными объектами MATLAB, применяемыми в научных исследо-
ваниях, являются числа, вектора и массивы. Создание объектов такого ти-
па можно выполнить с помощью соответствующих команд: 
>> a = 2 
>> a = [2 5 6 8 9]     или     >> a = [2; 5; 6; 8; 9] 
>> a = [2 5 6; 8 9 1; 4 3 0] 
Простейшие арифметические операции – сложение и вычитание – 

реализуются с помощью операторов «+» и «–»: 
>> z = x + y           или                      >> z = x – y 
Массивы или вектора x и y должны иметь одинаковую размерность. 
Создайте переменные следующих типов и выполните над ними опера-
ции сложения и вычитания: 
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число число 
вектор-строка вектор-строка 
вектор-столбец вектор-столбец 
массив массив 
вектор число 
массив число 

 
Умножение в MATLAB может быть двух типов: поэлементное «.*» и 

матричное «*». Для чисел эти операции равнозначны. Поэлементное про-
изведение массивов или векторов одинаковой размерности x и y (массивы 
или вектора как бы накладываются друг на друга, и определяются произ-
ведения соответствующих элементов массивов): 
>> z = x .* y 
Порядок поэлементного перемножения переменных не важен. 
Матричное произведение сложнее: строки матрицы x умножаются на 

столбцы матрицы y, и суммы этих произведений составляют соответст-
вующие элементы матрицы z. 
>> z = x * y 
Количество столбцов матрицы x должно равняться количеству строк мат-
рицы y. Порядок матричного перемножения переменных важен. 
Создайте переменные следующих типов и выполните над ними опера-
ции поэлементного умножения: 

число число 
вектор-строка вектор-строка 
вектор-столбец вектор-столбец 
массив массив 
вектор число 
массив число 

Создайте переменные следующих типов и выполните над ними опера-
ции матричного умножения: 

число число 
вектор-строка вектор-столбец 
вектор-столбец вектор-строка 
массив массив 
вектор число 
массив число 
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Деление в MATLAB может быть четырех типов: поэлементное правое 
«./» и левое «.\», а также матричное правое «/» и левое «\». Правое де-

ление выполняет операцию y
xx/y = , а левое –  x

yy\x = . 

Для чисел поэлементные и матричные операции равнозначны. Поэлемент-
ное деление массивов или векторов одинаковой размерности x и y (мас-
сивы или вектора как бы накладываются друг на друга, и определяются ча-
стные соответствующих элементов массивов): 
>> z = x ./ y        или                >> z = x .\ y 
Матричное деление используется при решении систем линейных урав-

нений и будет рассмотрено в лабораторной работе № 6. 
Найдите результат деления чисел с помощью операции матричного 
деления. Создайте переменные следующих типов и выполните над 
ними операции правого и левого поэлементного деления: 

число число 
вектор-строка вектор-строка 
вектор-столбец вектор-столбец 
массив массив 
вектор число 
массив число 

Возведение в степень также может быть поэлементным «.^» или мат-
ричным «^»: 
>> z = x .^ y (элементы массива x возводятся в степень из масс. y) 
>> z = x ^ y (квадратная матрица x умножается сама на себя y раз)    
Вычислите 144=z , 3 8=z , 24−=z , 102=z . 

 
 

Лабораторная работа № 2 
СПЕЦИАЛЬНЫЕ СИМВОЛЫ MATLAB 

 
«:» – индексирование массива. Применяется для формирования векторов 
и массивов. 
>> x = 1:9    («начало вектора» : «конец вектора») 
>> x = 1:2:9  («начало вектора» : «шаг» : «конец вектора») 
Сформируйте вектор из чисел от 5 до 55 с шагом 10; от 5 до -10 с ша-
гом -5. 
 
«( )» – круглые скобки используются для указания последовательности 
выполнения операций, для указания аргументов функций и при индекси-
ровании векторов и матриц. 
>> z = (2 + 4) * 5 
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>> z = sin(pi) 
>> z = x(3)     или        >> z = x(1,2) 
 
«[ ]» – квадратные скобки применяются при формировании массивов 
(см. арифметические операции). 
>> x = []            (создание пустого массива) 
Сформируйте из чисел 2, 3, 8, -6, 9, 0 вектор, массивы из 2 и из 3 строк. 
 
« . » – десятичная точка применяется при задании десятичных дробей: 
>> x = 1.25 
Сформируйте вектор из чисел от 0 до 1.5 с шагом 0.1. 
 
« ... » –  продолжение строки используется при вводе длинных команд: 
>> x = [1 3 5 4 5 6 ...        (здесь нужно нажать Enter) 
5 4 3 2 1 2 3]                        (окончание команды, нажать Enter) 
В результате формируется вектор 
x = 
   1 3 5 4 5 6 5 4 3 2 1 2 3 
 
« , » – разделяет элементы векторов-строк, аргументы функций, матрич-
ные индексы (номера строк и столбцов) и операторы в одной командной 
строке: 
>> x = [1, 3, 5, 4, 5, 6] 
>> z = x(1,2) 
>> y = x + 2, z = x + 3 (выполняются две операции, их результа-
ты выводятся на экран). 
 
 
« ; » – разделение строк матриц, разделение операторов в командной 
строке и подавление вывода результата операций на экран 
>> x = [1 3 5; 4 5 6] 
>> y = x + 2; z = x + 3;  (выполняются две операции, результа-
ты не выводятся на экран; это удобно при промежуточных вычислениях). 
 
« % » – после этого символа пишется комментарий, т.е. любой поясняющий 
текст, игнорируемый системой: 
>> y = 20 % координата Y в метрах 
 
« = » – оператор присваивания 
>> x = 5 % переменной x присвоено значение 5 
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«’» –  апостроф используется для задания текстовых строк и транспониро-
вания матриц и векторов: 
>> a = ’Это текстовая строка’ 
>> x = [2 3 4 5], y = x’    % строка x, столбец y 
 
 

Специальные переменные и константы MATLAB 
 
ans (от английского слова answer – ответ) – переменная содержит резуль-
тат последней арифметической операции, если результат не был присвоен 
какой-либо переменной: 
>> 2 + 3 % явного присваивания нет, результат - в ans 
ans = 
     5 
>> x = 2 + 3 % результат операции присвоен переменной 
x 
x = 
     5 
Переменная ans может быть использована при выполнении последующих 
команд. Например, выражение ans+4 будет воспринято системой как ко-
манда, требующая увеличить значение переменной ans на 4. 
 
pi – число π . Чтобы вывести на экран значение любой переменной 
или константы, нужно ввести ее имя в командной строке и нажать En-
ter. 
 
i или j – мнимая единица ( 1− ), т.е. комплексное число. Выведите на 
экран значения этих чисел. При желании можно изменить значения этих 
переменных: 
>> i = 5, j = 7 
Для того, чтобы восстановить значения специальных переменных и кон-
стант, необходимо выполнить очистку рабочей области командой 
clear all. При этом удаляются все переменные из памяти MATLAB. 
Inf – бесконечность (∞ ). Возникает, например, при  делении на 0. С кон-
стантой Inf можно выполнять такие же операции, что и с числами. 
 
NaN – неопределенность (Not a Number). Не является численным объектом. 
Возникает при делении 0/0 или ∞ /∞ . 
 

 



 

 

 

12 

Элементарные функции MATLAB 
 

В системе MATLAB имеется обширная библиотека математических 
функций, благодаря которым MATLAB может использоваться как мощный 
математический калькулятор. Каждой функции соответствует определен-
ное имя. Функция возвращает результат в зависимости от значений аргу-
ментов. Аргументы функции – числа, вектора или массивы – указываются 
в круглых скобках. 
 
abs(x) – возвращает модуль (абсолютное значение)  x. 
sign(x) – возвращает знак (абсолютное значение)  x. 
Определите модуль и знак положительных и отрицательных чисел, 
векторов, массивов. 
 
angle(x), real(x), imag(x) – возвращают соответственно аргу-
мент, вещественную и мнимую часть комплексных чисел. abs(x) для 
комплексных чисел возвращает модуль. Определите значения этих 
функций для комплексного числа x = 3 + 4i. 
 
ceil(x), fix(x), floor(x), round(x) –  функции округления 
вещественных чисел: до большего целого, отбрасывание дробной части, до 
меньшего целого и до ближайшего целого соответственно. Округлите с 
помощью этих функций дроби: 4.3,  4.6,  –5.2,  –5,8. 
 
Тригонометрические функции: 
sin(x), csc(x), cos(x), sec(x), tan(x), cot(x) – синус, 
косеканс, косинус, секанс, тангенс, котангенс. Аргумент x указывается в 
радианах. Чтобы перевести аргумент y из градусов в радианы, можно 
воспользоваться формулой x = y / 180 * pi. 
Вычислите тригонометрические функции углов: 30°, 60°, 45°, 90°. 
 
Обратные тригонометрические функции: 
asin(x), acos(x), atan(x), acot(x) – арксинус, арккосинус, 
арктангенс, арккотангенс. Результат возвращается в радианах. 
Чтобы перевести угол y из радиан в градусы, можно воспользоваться фор-
мулой z = y * 180 / pi. 
Вычислите обратные тригонометрические функции 0.5, 1, –0.866, –0.5, 0. 
 
log(x), log10(x) – натуральный ( xln ) и десятичный ( xlg ) логариф-
мы. Вычислите натуральный логарифм 2.71828, 1/2.71828, десятичный 
логарифм 100, 10000, 0.01, –1, 0. 
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exp(x) – функция экспоненты ( xe ). Определите значение числа e , экс-
поненту нуля 0e , экспоненту натурального логарифма 5 ( 5lne ). 
 
sqrt(x) – функция извлечения квадратного корня. Найдите корень од-
ной переменной, вектора и массива. 
 

Специальные массивы, матрицы и операции над ними 
 

zeros(n) или zeros(m,n) – формирование вектора длиной n или мас-
сива размером m x n, заполненных нулями. 
ones(n) или ones(m,n) – формирование вектора длиной n или массива 
размером m x n, заполненных единицами. 
Создайте строку и столбец длиной 7, заполненные нулями и единицами. 
eye(n) – формирование единичной матрицы размером n x n. 
Создайте единичные матрицы размером 2 x 2, 5 x 5. 
 
Определение размеров массивов и векторов: 
size(a) – определение количества строк и столбцов массива a. 
length(a) – определение длины вектора a. 

 
 

Лабораторная работа № 3 
ДВУМЕРНЫЕ ГРАФИКИ MATLAB 

 
В научных исследованиях для анализа зависимостей между изучаемы-

ми показателями часто используются графики, показывающие связь двух 
величин. Двумерные графики в MATLAB строятся с помощью функции 
plot(). Формы вызова этой функции: 
plot(y) – по оси абсцисс указываются номера точек, по оси ординат – 
значения из массива y. Если y – массив, графики строятся для каждого 
столбца. 
plot(x, y) – график y  в зависимости от x. x и y должны иметь одина-
ковую размерность. 
plot(x, y, ’*’) – точки данных изображаются в виде звездочек. Вы-
ражение в апострофах – это атрибут графика. Атрибуты, позволяющие 
управлять стилем изображения графиков, могут быть сочетаниями сле-
дующих символов: 
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Тип линии Тип точек данных Цвет 

Непрерывная 
Штриховая 
Пунктир 
Штрих-пунктир 

- 
-- 
: 
-. 

Точка 
Плюс 
Звездочки 
Кружок 
Крестик 
Треугольник 
Квадрат 
Ромб 

. 
+ 
* или p или h 
o (Малое латинское) 

x (Малое латинское) 

^ или < или >  или v 
s 
d 

Желтый 
Фиолетовый 
Голубой 
Красный 
Зеленый 
Синий 
Белый 
Черный 

y 
m 
c 
r 
g 
b 
w 
k 

 
Например: 
y = [1 3 5 6 7 7.5 7.8 8 8.1],  plot(y, ’:+g’) 
Управление цветами также осуществляется с помощью функции 

whitebg, которая меняет цвет фона и графиков на противоположный.   
Команда типа plot(x1, y1, ’-*’, x2, y2, ’-.’) позволяет 

строить несколько графиков с разными атрибутами в одном окне. 
Постройте графики, используя разные атрибуты, для следующих дан-
ных:      y = [2 4 5 6 5 4 3 4 5 6 7 8 7 6 7 8 9]; 
x = [3 5 7 9 11 13 15], y = [12 11.5 10 9.5 8 7.5 4]; 

x = [50 100 150 200], y = 



















6427
4455
2482
0491

. 

Построение графиков различных функций выполняется следующим 
образом. Сначала задается интервал и шаг изменения аргумента x, при 
этом формируется вектор x. Шаг изменения x нужно выбирать так, чтобы 
обеспечить достаточную точность изображения графика. В зависимости от 
x вычисляется у по заданной функции, и формируется вектор y той же 
длины, что и x. Затем строится график командой plot. Например, постро-
им график синуса на интервале от 1 до 10: 
x = 1:0.01:10; % задаем аргумент x с шагом 0.01 
y = sin(x); % вычисляем у – это вектор из 901 чисел 
plot(x, y, ’.r-’) % строим график 
Наложение координатной сетки на график производится командой 

grid:    grid (выключить или включить сетку), grid on (включить), 
grid off (выключить). 
Режим увеличения участков графика с помощью мыши включается 

командой zoom:    zoom (выключить или включить), zoom on (вклю-
чить), zoom off (выключить). 
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Выделить интересующий участок графика (в том числе уменьшить 
график) можно с помощью команды управления осями координат: 
axis([xmin xmax ymin ymax]) – будет показан участок, ограниченный 
координатами xmin, xmax, ymin, ymax. Например: 
axis([-5 5 0 20]) % Интервал по X от -5 до 5, по Y от 0 до 20. 
Надписи в графическом окне могут быть добавлены командами: 

title(’Заголовок’) – выводит заголовок графика; 
xlabel(’Надпись по X’) – выводит надпись по оси абсцисс; 
ylabel(’Надпись по Y’) – по оси ординат. 
По умолчанию каждая команда plot заменяет старый график на но-

вый в графическом окне Figure1. Режим наложения графиков в одном 
окне включается командой удержания окна hold: 
hold (выключить или включить), hold on (включить), hold off (вы-
ключить). Например: plot(x1, y1); hold on; plot(x2, y2) 
Наложите график функции косинуса на график синуса (разными сти-
лями), создайте координатную сетку и включите режим увеличения 
графиков. Обозначьте оси, вставьте заголовок графика. 
Одновременно в системе можно держать открытыми несколько графи-

ческих окон. При этом график строится в активном окне, которое послед-
ний раз было выбрано с помощью мыши. Команда создания нового пусто-
го графического окна figure. Окна нумеруются автоматически. 
Создайте 3 графика в разных графических окнах. Покажите область 
по X от -10 до 10, по Y от -20 до 20. 
Графическое окно также можно разбивать на независимые области – 

подокна, в каждом из которых можно строить отдельный график. Для 
этого служит команда subplot(m, n, k), где m – количество окон по 
вертикали, n – по горизонтали, k – номер активного подокна, где будет 
построен график. Например: subplot(2, 3, 1), plot(x1, y1)  – 
разбивает графическое окно на 6 частей, первое из которых активно, и где 
строится график. subplot(2, 3, 2), plot(x2, y2) – график 
строится во втором подокне из 6, и т. д. 
Разбейте графическое окно на 4 части, и в каждом подокне постройте 
график с координатной сеткой. 

Постройте разными стилями графики функций, наложите коорди-
натную сетку: 
1) 32 2 += xy , [ ]2;2−∈x ;                    2) ( ) 432 3 −−= xy , [ ]8;5−∈x ; 
3) xey x 4−= , [ ]5;5−∈x ;                     4) ( ) xxy /sin= , [ ]10;1∈x . 
Обратите внимание: необходимо использовать поэлементные арифме-
тические операции. Шаг x выберите самостоятельно. 
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Лабораторная работа № 4 

ТРЕХМЕРНЫЕ ГРАФИКИ MATLAB 
 

Взаимосвязи трех исследуемых показателей визуально отображаются в 
виде трехмерных графиков. Это позволяет, например, оценить поведение 
исследуемой величины z в зависимости от изменения факторов x и y. 
Простейший трехмерный график – это линия в пространстве (напри-

мер, так можно изобразить траекторию движения материальной точки). 
Такой график строится с помощью функции plot3() – трехмерного ана-
лога функции plot(). 
plot3(x, y, z), где x, y, z – вектора одинаковой длины, строит 
точки с координатами x(i), y(i), z(i) и соединяет их прямыми. 
plot3(x, y, z, ’*-’) – строит график с учетом заданного атрибута. 
plot3(X, Y, Z), где X, Y, Z – массивы одинаковой размерности, 
строит отдельную линию для каждого столбца 
X(i,:), Y(i,:), Z(i,:), цвета линий циклически чередуются. 
plot3(X, Y, Z, ’*-’) – строит семейство линий с учетом заданного 
атрибута. 
Технология построения объемных фигур в MATLAB такова. 

1). Задаются интервалы и шаг изменения x и y (так же, как интервал изме-
нения аргумента для плоских графиков). Формируются вектора x и y. 
2). Вычисляются координаты точек вспомогательной плоскости XY, над 
которой будет построена поверхность z. Для этого используется функция 
meshgrid. В результате формируются массивы координат X, Y. 
3). В зависимости от значений координат вспомогательной плоскости X и Y 
вычисляется высотная координата поверхности z. 
4). Строится график объемной фигуры. 
Например, построим трехмерный график функции 

22 yxexz −−⋅=  на ин-
тервале [ ]2;2−∈x , [ ]2;2−∈y . 
x = -2:0.1:2;   % задаем интервал и шаг изменения x 
y = -2:0.1:2;   % задаем интервал и шаг изменения y 
[X, Y] = meshgrid(x,y); %Вспомогательная плоскость XY 
z = X .* exp(- X.^2 - Y.^2); % z в зависимости от X,Y 
plot3(X, Y, z, ’*-’) % график в виде семейства линий 
Команды grid, zoom, hold, subplot, figure, title, 

xlabel, ylabel используются так же, как для двумерных графиков. 
Надпись по оси z можно добавить командой zlabel(’Ось Z’). 
Управление осями координат с учетом третьей оси z: 
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axis([xmin xmax ymin ymax zmin zmax]) – будет показан участок, огра-
ниченный координатами xmin, xmax, ymin, ymax, zmin, zmax. Например, 
axis([-1 1 -1 1 -0.1 0.1]) увеличит центральную часть графи-
ка. 
Режим трехмерного вращения графика с помощью мыши включается/ 

выключается командой rotate3d. 
Проекцию трехмерной поверхности на плоскость XY, т.е. линии уров-

ня, можно получить с помощью функции contour(x, y, z), Такие 
изолинии используются для исследования экстремумов z. Координата z 
формируется по описанной выше методике. 
Линии уровня z в пространстве строятся функцией con-

tour3(x, y, z). 
Трехмерная сетчатая поверхность, цвет которой меняется в зависи-

мости от высоты по шкале z,  строится с помощью функции 
mesh(x, y, z).  
meshс(x, y, z) – сетчатый график с линиями уровня. 
meshz(x, y, z) – сетчатый график с плоскостью отсчета на нулевом 
уровне, ограниченный вертикальными плоскостями. 
Трехмерная сплошная поверхность строится с помощью функции 

surf(x, y, z).  
surfl(x, y, z) – сплошная поверхность с подсветкой. 
surfc(x, y, z) – сплошная поверхность с линиями уровня. 
Поверхности изображаются в разных цветовых гаммах в зависимости 

от выбранной палитры. Управление палитрой осуществляется функцией 
colormap(’Название палитры’). Например, colormap(’hot’) 
включает яркие оттенки. Название палитры можно выбирать из следую-
щих: hot, hsv, gray, bone, copper, pink, flag, cool. 
Управление подсветкой графика обеспечивается командой shading: 

shading faceted  – подсветка по сегментам (по умолчанию), 
shading flat  – делает ребра сегментов невидимыми,  
shading interp  – интерполяция (сглаживание) цветов.  

Постройте все виды рассмотренных трехмерных графиков. Срав-
ните между собой различные цветовые палитры и режимы подсветки. 

Постройте трехмерные графики следующих функций, наложите 
координатную сетку, включите режим вращения графиков: 
1) ( ) ( ) 221 22 +−++= yxxz ,      [ ]5;5−∈x ,     [ ]5;5−∈y ; 

2) ( ) ( ) 23
2
152 22 −+−−= yxz ,           [ ]10;10−∈x , [ ]8;15−∈y ; 

3) xeyz x 4sin −⋅= ,                             [ ]10;10−∈x , [ ]20;20−∈y ; 
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4) xtgyz ⋅= 2 ,                                      



 ππ

∈
2

;
3

x ,    [ ]20;20−∈y . 

Обратите внимание: необходимо использовать поэлементные 
арифметические операции. Шаг x и y выберите самостоятельно. 

 
 
 

Лабораторная работа № 5 
АППРОКСИМАЦИЯ И ИНТЕРПОЛЯЦИЯ ДАННЫХ 

 
Аппроксимация данных полиномом 

 
Целью анализа экспериментальных данных часто является выявление 

аналитической зависимости между случайными переменными. При этом 
какая-либо физическая величина определяется как функция другой вели-
чины: ( )xfy = . Такую функциональную зависимость называют регресси-
онной моделью. Распространенным подходом к построению регрессион-
ных моделей на основе экспериментальных данных является подбор функ-
циональной зависимости n

n xaxaxaay ++++= ...2
210 . Такой подход на-

зывается аппроксимацией данных полиномом (многочленом) n -й степени. 
Коэффициенты полинома 0a , 1a , ..., na  подбираются по критерию 

наименьших квадратов ошибки. В MATLAB коэффициенты аппроксими-
рующего полинома степени n определяются функцией 
p = polyfit(x, y, n) 
p – это вектор-строка, содержащая коэффициенты в порядке na , ..., 1a , 0a . 
После расчета коэффициентов полинома задается интервал x с равно-

мерным малым шагом, и на этом интервале рассчитывается значение вели-
чины y по модели с помощью функции polyval. Расчетные значения по 
модели на интервале xm вычисляются следующим образом: 
ym = polyval(p, xm) 
Затем строятся график экспериментальных значений x и y и график 

регрессионной модели (прогнозные значения ym). 
Например, необходимо построить полиномиальную модель 3-го по-

рядка 3
3

2
210 xaxaxaay +++=  для буксования y  в зависимости от тягово-

го усилия x  колесной землеройно-транспортной машины и затем спрогно-
зировать среднее значение буксования при тяговом усилии =x 22 кН. Ис-
ходные экспериментальные данные: 
% сила тяги в кН: 
x = [0 1.3 4.7 5.0 7.0 9.1 9.5 10.7 11.0 11.5 11.8 12.4 ... 
13.0 14.4 14.8 15.5 16.3 16.4 16.7 16.8 18.7 19.2 19.7 ... 
23.0 23.6 24.7 26.0 27.85 30 30.5]; 



 

 

 

19 

% буксование: 
y = [0 0.007 0.015 0.01 0.017 0.035 0.042  0.052 0.049  0.05 
... 
0.038  0.051  0.04  0.048 0.06  0.073  0.09  0.13  0.17 ... 
0.11   0.2  0.23  0.21  0.38  0.49  0.5  0.53  0.71  1  0.99]; 
plot(x, y, ’.b’); grid on; hold on % график эксперим. данных 
xlabel(’Cила тяги, кН’); ylabel(’Буксование’) 
% вычисляем коэффициенты полинома 3-й степени p: 
n = 3; 
p = polyfit(x, y, n) 
% Задаем интервал x с равномерным мелким шагом: 
xm = 0:0.1:30.5; 
% Расчетные значения y по полиномиальной регрессионной модели: 
ym = polyval(p, xm); 
plot(xm, ym, ’g’); % график регрессионной модели 
% Точечный прогноз буксования при силе тяги 22 кН: 
xm = 22; ym = polyval(p, xm); plot(xm, ym, ’r*’); 

 
Постройте линейную модель парной регрессии (полином 1 степе-

ни) для тяговой мощности автогрейдера ДЗ-143-1 y  (кВт) в зависимо-
сти от силы тяги x  (кН) на второй передаче: 
x=[26.1064 23.5488 22.9819 22.8450 26.0743 26.3049 24.0401 ... 
   29.2168 31.9103 28.6852 28.4548 24.3532 25.0969 26.4924 ... 
   23.1202 24.3695 23.0572 23.5488 23.5488 22.5676 24.7159 ... 
   26.6253 24.9035 27.4736 25.1666 22.5204 25.9831 34.5612 ... 
   35.7871 33.3608 33.8727 32.3796 29.4360 25.5112 27.4736 ... 
   24.5300 28.0405 28.4548 32.8197 28.3894]; 
 
y=[37.2949 33.6411 31.9193 30.8716 36.2143 37.5784 31.6318 ... 
   39.4822 44.3198 38.7639 38.4524 33.8239 35.8527 37.8463 ... 
   30.4213 32.9317 32.0239 32.7067 32.7067 31.3439 36.3470 ... 
   40.3413 36.6228 40.4024 38.1312 33.1183 35.1123 45.4752 ... 
   48.3609 45.0822 47.0454 44.9717 40.8833 35.4322 38.1578 ... 
   34.0694 40.0578 40.6497 45.5829 40.5562]; 
В версиях MATLAB 6.x в меню графических окон Tools есть инстру-

мент Basic Fitting, позволяющий автоматически аппроксимировать данные 
полиномами, выводя уравнение регрессионной модели на экран. 
Построение регрессионных моделей возможно также в системе Micro-

soft Excel. Для этого необходимо разместить исходные данные x  и y  в 
строках или в столбцах, выделить их мышью, и построить точечную диа-
грамму с помощью Мастера Диаграмм (меню Встав-
ка→Диаграмма). Затем щелкнуть правой кнопкой мыши по точкам ис-
ходных данных на графике и выбрать в выпадающем подменю пункт До-
бавить линию тренда. Затем в окне Линия тренда выбрать тип мо-
дели (полиномиальная или линейная) и во вкладке Параметры указать 
Показывать уравнение на диаграмме. 
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Постройте для двух рассмотренных примеров регрессионные мо-
дели с помощью Мастера диаграмм MS Excel. 

 
Интерполяция данных 

Интерполяция в математике и статистике – это отыскание промежу-
точных значений величины по некоторым известным ее значениям. На-
пример, отыскание значений функции f (x) в точках х, лежащих между точ-
ками (узлами интерполяции) x0 < x1 < ... < xn, по известным значениям yi = f 
(xi) (где i = 0, 1, ..., n). 
Если точки, соответствующие исходным экспериментальным данным х 

и y, на графике соединять прямыми отрезками, график будет иметь вид 
ломаной линии. Однако многие процессы в природе и технике описывают-
ся гладкими кривыми. Для построения таких графиков необходимо выпол-
нить интерполяцию – вычисление промежуточных значений y между точ-
ками экспериментальных данных. 

 
Одномерная табличная интерполяция 

Пусть вектора x  и y  содержат экспериментальные (табличные) дан-
ные, показанные на графике плюсами: 
x = 0:10; 
y =[0 0.8415 0.9093 0.1411 -0.7568 -0.9589 ... 
-0.2794 0.6570 0.9894 0.4121 -0.5440]; 
plot(x, y, ’+’); grid on; hold on 
Табличные данные x  изменяются с шагом 1. Для вычисления проме-

жуточных значений, т.е. интерполяции данных, нужно задать интервал xi  
с более мелким шагом: 
xi = 0:0.1:10; 
Промежуточные значения yi  вычисляются с помощью функции interp1, 
при этом могут применяться разные методы сглаживания: 
yi1 = interp1(x, y, xi, ’linear’); % линейная интерп. 
plot(xi, yi1, ’b’) 
yi2 = interp1(x, y, xi, ’cubic’);  % кубическая инт. 
plot(xi, yi2, ’g’) 
yi3 = interp1(x, y, xi, ’spline’); % инт. сплайнами 
plot(xi, yi3, ’r’); hold off 
Сплайны – это алгебраические многочлены третьей степени. Сравните 
графики, построенные разными методами сглаживания. 

Задайте произвольные вектора x  и y  из 7 чисел каждый (значения 
x  должны изменяться монотонно – только возрастать или убывать). 
Выполните одномерную табличную интерполяцию. 
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Двумерная табличная интерполяция 
 

Экспериментальные данные, которые графически могут быть пред-
ставлены как точки в трехмерном пространстве с координатами X , Y  и Z , 
могут быть интерполированы с помощью функции interp2. 
Вначале сформируем исходные данные – некоторую поверхность Z  на 

двумерной сетке X , Y : 
x = -2:0.5:2; % интервал и шаг изменения X 
y = -2:0.5:2; % интервал и шаг изменения Y 
[X, Y] = meshgrid(x, y); % исходная 2-мерная сетка XY 
Z=X.*exp(-X.^2-Y.^2); % пусть это исходные значения Z 
plot3(X, Y, Z, ’b.’) % график для исходных данных 
grid on, hold on 
Задаем мелкую сетку XI , YI  с шагом 0,1: 

xi = -2:0.1:2; % интервал и мелкий шаг изменения XI 
yi = -2:0.1:2; % интервал и мелкий шаг изменения YI 
[XI, YI] = meshgrid(xi, yi); % мелкая сетка XI,YI 
Затем вызываем функцию интерполяции, которая может использовать 

два метода сглаживания (линейная и кубическая интерполяция): 
ZI1 = interp2(X, Y, Z, XI, YI, ’linear’); % линейная 
mesh(XI, YI, ZI1); rotate3d 
hidden off  % прозрачный график 
Линейная интерполяция соединяет точки исходных данных плоскостя-

ми. Для получения гладкой поверхности используется кубическая интер-
поляция: 
ZI2 = interp2(X, Y, Z, XI, YI, ’cubic’); % кубическая 
mesh(XI, YI, ZI2) 
hidden off, hold off 

 
 

Лабораторная работа № 6 
РЕШЕНИЕ СИСТЕМ ЛИНЕЙНЫХ УРАВНЕНИЙ 

 
Широкий класс математических моделей, в особенности применяемых 

при решении экономических задач и планировании производства, основан 
на решении систем линейных уравнений: 
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где a  и b  – постоянные коэффициенты, jx  – переменные. 
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В матричной форме система уравнений записывается следующим образом: 
BAX = . 

В случае mn =  матрица коэффициентов ( )ijaA =  является квадратной, 
и система имеет единственное решение. Условие решения системы урав-
нений – определитель матрицы A  должен быть отличен от нуля: 0≠A . 
Определитель вычисляется с помощью функции MATLAB det: 
det(A) 
Вектор-столбец переменных ( )T

nxxxX ,...,, 21=  можно определить с 
помощью обратной матрицы: BAX 1−= . Обратная матрица 1−A  вычисля-
ется с помощью функции inv: 
inv(A) 
Матричное произведение исходной и обратной матриц дает единичную 

матрицу: 
inv(A) * A,   A * inv(A) 
Решение системы линейных уравнений можно найти следующим образом: 
X = inv(A) * B 

( )T
mbbbB ,...,, 21=  – это вектор-столбец из коэффициентов правой части 

системы уравнений. 
Найдите определители и обратные матрицы, а также произведения 

исходных и обратных матриц: 
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Решите систему линейных уравнений с помощью обратной матрицы: 
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Решение X  может быть найдено с помощью решателя систем ли-
нейных уравнений – матричного деления: 
X = A \ B     % X и B - это вектора-столбцы 
X = B / A’    % X и B - это вектора-строки 
Решите предыдущую систему линейных уравнений с помощью «/» и 
«\». 
Если количество переменных превышает количество уравнений в сис-

теме mn > , то система имеет в общем случае бесконечное множество ре-
шений. Решатели «/» и «\» позволяют находить одно из базисных решений 
такой системы. 
Решите систему линейных уравнений с помощью «/» и «\»: 
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
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Все базисные решения этой системы можно найти, если принимать по две 
переменных (например, 1x  и 2x , или 1x  и 3x , и т.д.) за 0, составлять матри-
цы A  размером 2х2 для оставшихся переменных и затем решать систему 
уравнений. 
Найдите несколько решений системы линейных уравнений: 
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Решение нелинейных уравнений 

 
Решение нелинейного уравнения с одной переменной в виде ( ) 0=xf  

осуществляется в MATLAB с помощью функции fzero. Решение ищется 
приближенно численными методами в окрестности точки 0x . Например, 
найдем корни нелинейного уравнения ( ) 092 2 =−−x  в окрестности точек 

20 −=x  и 60 =x : 
x = fzero('(x-2).^2-9', -2) 
x = fzero('(x-2).^2-9', 6) 
Выражение в апострофах – это текстовая строка, содержащая левую 

часть уравнения ( ) 0=xf  с переменной x. Здесь также можно указывать 
имя функции MATLAB, стандартной или написанной пользователем в M-
файле. Например, решение уравнения 0cos =x  в окрестности точки 

5,10 =x  находится так: 
x = fzero('cos', 1.5) 
Решите нелинейные уравнения: 

0124 34 =+− xx ;     ( ) 12sin2 −=−x . 
 

Интегрирование обыкновенных дифференциальных уравнений 
 

Научные исследования динамических, т.е. развивающихся во времени, 
процессов с помощью детерминистских математических моделей основа-
ны на решении дифференциальных уравнений. В частности, динамику ме-
ханических систем, динамику рабочих процессов машин можно описать 
системой обыкновенных дифференциальных уравнений (ОДУ). Перемен-
ными величинами, зависящими  от времени t , в этом случае могут быть 
координаты ( )tx , скорости ( )tv  элементов машин и т.п. 
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Для нахождения приближенного решения численными методами в 
MATLAB система нелинейных ОДУ должна быть сведена к системе диф-
ференциальных уравнений первого порядка и представлена в форме задачи 
Коши: 

( )tXF
dt
dX ,= , 

где ( )T
nxxxX ...,,, 21=  – вектор состояния, содержащий переменные jx  

(координаты, скорости и т.п.); 
( )T

nfffF ...,,, 21=  – вектор нелинейных функций jf  от переменных X  и 
времени t , т.е. содержит правые части дифференциальных уравнений. В 
развернутой форме можно записать систему ОДУ следующим образом: 
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Для интегрирования ОДУ в MATLAB имеется ряд программных функций. 
Рассмотрим 2 из них: ode23 и ode45. Они реализуют методы Рунге-
Кутты 2 и 3, а также 4 и 5 порядков. 
[t, X] = ode23(’имя функции’, [t0 tf], x0)   или 
[t, X] = ode45(’имя функции’, [t0 tf], x0) 
Аргументы решателей систем ОДУ: 

’имя функции’ – указывается имя написанной пользователем функции 
MATLAB, вычисляющей значения ( )tXF ,  и возвращающей вектор-
столбец; эта функция должна храниться в одноименном M-файле, и путь к 
этому файлу должен быть добавлен к списку путей MATLAB (см. стр. 5); 
t0 и tf – начальное и конечное значение времени t  (интервал интегриро-
вания ОДУ); 
x0 – вектор-столбец начальных условий, т.е. значения переменных 

nxxx ...,,, 21  в начальный момент времени t0. 
В результате возвращается вектор текущих моментов времени t и дву-

мерный массив X, где каждый столбец соответствует одной переменной, а 
строка – моменту времени t. 
Рассмотрим дифференциальное уравнение 2-го порядка – уравнение 

Ван дер Поля: ( ) 012 =+−+ xxxx &&& . Пусть x  – это координата материальной 
точки, тогда x&  – это ее скорость, x&&  – ускорение. Это уравнение может 
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быть представлено в форме Коши. Для этого вводим обозначения пере-
менных: 

xx =1 ; xx &=2 . 
Задача в форме Коши: 

( )
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Правые части системы уравнений: 
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Первый шаг процедуры интегрирования ОДУ – это создание M-файла 
для вычисления правых частей ОДУ. С помощью пункта главного меню 
File→New→M-File вызываем редактор-отладчик Editor/Debugger. 
В этом окне необходимо набрать текст программы, вычисляющей правые 
части ОДУ: 
function f = fright(t, x) % Имя функции fright 
f(1,1) = x(2); % правая часть первого ОДУ 
f(2,1) = x(2).*(1-x(1).^2)-x(1); % правая часть 2го 
ОДУ 
С помощью пункта меню редактора-отладчика File→Save As сохра-
ним этот файл обязательно под тем же именем fright.m в рабочем ка-
талоге, например, в папке d:\Study\31SM. Переключившись в окно 
управления MATLAB, нужно добавить путь к этому файлу, например, с 
помощью команды (см. стр. 5) 
 >> path(path, ’d:\Study\31SM’) 
Чтобы проинтегрировать систему на временном интервале 200 ≤≤ t  с 

начальными условиями 01 =x  и 25,02 =x , следует вызвать ode23: 
t0 = 0; tf = 20; % начальный и конечн. момент времени 
x0 = [0; 0.25];  % начальные условия 
[t, X] = ode23(’fright’, [t0 tf], x0) 
plot(t, X); grid on; xlabel(’t’) 
% синяя линия - координата x1, зеленая – скорость x2 

 
Другой пример: промоделируем движение точки по заданному закону 

в трехмерном пространстве. 
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где 2,0=a , 2,0=b , 7,5=c , а начальные условия – 7,00 −=x , 7,00 −=y , 
10 =z . 



 

 

 

26 

Вводим обозначения переменных: xx =1 , yx =2 , zx =3 . Создаем M-
файл для вычисления правых частей ОДУ: 
function f = fright1(t, x) % Имя функции fright1 
f(1,1) = -x(2)-x(3);        % правая часть 1го ОДУ 
f(2,1) = x(1) + 0.2 * x(2); % правая часть 2го ОДУ 
f(3,1) = 0.2 + x(3).*(x(1)-5.7); % пр. часть 3го ОДУ 
Cохраним этот файл под тем же именем fright1.m в рабочем каталоге. 
Чтобы проинтегрировать систему на временном интервале 1000 ≤≤ t  

вызываем ode45: 
t0=0; tf=100; % начальный и конечный моменты времени 
x0 = [-0.7; -0.7; 1];  % начальные условия 
[t, X] = ode45(’fright1’, [t0 tf], x0) % интегриров. 
comet3(X(:,1), X(:,2), X(:,3)); grid on; % график 
xlabel(’x’), ylabel(’y’), zlabel(’z’) 
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